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Steps to Create a File 

1. Create or Open a DataGate Project 

DataGate file definitions are contained in DataGate projects.  You may create a new 

project, or open a new project, using the DataGate Studio File menu.  When you 

open or create a project, Solution Explorer displays the solution in the IDE, showing a 

DataGate project, or a collection of projects.  Source files in DataGate projects are 
used to create database and print files. 

2. Add New Database File Definition 

Creates a Database File Definition for a Physical, Simple, Join, Multiformat or 

Print file that contains the collection of information regarding the type of file 

being created, and how data in the file will be accessed and stored. The record 

format will also be created, along with a field key, Join definition and Select/Omit 

node (for Join and Multiformat files only). 

3. Open the Database File Definition Designer 

The database file definition designers show editable file definition parameters in 

several easy to use display panels.  Or if you prefer, you may edit file definition 

XML code in the XML editor. 

4. Add Field(s) to the Record Format 

Adds fields that make up a record format. 

5. Add Key(s) to the Record Format 

Adds keys to the selected record format to determine the order and usage of how 

records will be retrieved from the file. 

6. Add Select/Omit Rule 

For logical files only, adds Select/Omit Rules to define which records to Select and 

Omit. 

7. Create the File 

Creates a new file and a member by using a database file definition in the 

DataGate project and creating the described file in the selected library in the 

desired database. 

8. Add Member(s) 

Adds members to a file in the database to store data in the format given by the 

database file definition. At least one member must be specified before a file can be 

used in a program. 



Creating a Database File                                                                                                            2 

Step 1 – Create or Open a DataGate Project 

To use file definition source files to create database and print files, you must 

organize them into a DataGate project.  The project is a list of source files and 

database references that should represent the file creation design and 
implementation portion of a particular database development task.   

Projects can be opened directly, or can be opened as members of a Visual Studio 

solution.  In the latter case, you open the solution file to access the projects of the 
solution. 

Creating a New DataGate Project 

To Create a New DataGate Project 

1. Select Project from the File - New menu.  The New Project dialog is displayed. 

2. Select DataGate from the list of available Project Types. 

Depending on your installation options for DataGate Studio, you may have several 

Project Types listed in the New Project dialog.  The DataGate project types are 
specific to DataGate tasks. 

3. Select DataGate File Definition Project from the installed templates list. 

The DataGate File Definition Project may contain a sample database definition source 

file.  You may use this as a starting point to begin your tasks, or simply delete the 

file and add your own. 

4. Modify the name, location, and solution options, if desired, of the new project. 

The Name field names the project file.  This name will be shown next to a project 

node when the project is open in Solution Explorer, and is also the name of your 
project file.  The project file has the “.dgproj” extension (e.g., “MyProject.dgproj). 

The location of the project may be specified as a file path on the local computer.  

Click the browse button to navigate to a particular folder in which to add the project 
file. 

By default, DataGate Studio will create a solution for your new project.  You may add 

a new DataGate project to an existing solution by first opening the solution, then 

creating the project.  On the New Project dialog, select “Add to Solution” from the 

Solution drop-down box instead of “Create new Solution”.   

If you have installed a Source Control provider that is compatible with DataGate 

Studio, you may elect to add your project to a source repository by selecting the 
“Add to Source Control” checkbox. 

5. Click OK. 

After creating the project, DataGate Studio will open the project (and its solution) in 

Solution Explorer. 
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Opening an Existing DataGate Project 

To Open an Existing DataGate Project 

1. Select Project/Solution from the File>Open menu.  The Open Project dialog is 

displayed. 

2. Navigate to the folder containing the DataGate project or its solution.  

The Open Project dialog is a file browser for you to navigate among the project and 

solution files on your computer.  By default, all solution files (extension “.sln” and 

project files are filtered).  To filter only the DataGate project files (extension 

“.dgproj”), select DataGate Project Files from the “Objects of type” drop down 

box. 

3. Select the project or solution.   

4. Select Add to Solution to add the project to the currently open solution, or select 

Close Solution to close the open solution before opening the project. 

By default, the Open Project dialog closes any currently open solution before opening 

another project.  Select Add to Solution as a way to add a selected project file to 

the currently open solution. 

5. Click OK to open the project, or Cancel to close the dialog without opening a project. 

Creating a New, Empty Solution 

There are two options for creating new solution files.  By default, DataGate Studio 

creates a new solution when you create a new DataGate project (see To Create a New 

DataGate Project above).  However, you may also create an empty solution file to which 

you can add existing or new project files. 

To Create a New, Empty Solution 

1. Select Project from the File - New menu.  The New Project dialog is displayed. 

2. Expand the “Other Project Types” node under Project Types.  Select Visual Studio 

Solutions under Other Project Types. 

3. Select Blank Solution under installed templates. 

4. Modify the name, location, and source control options of the new solution; if desired. 

5. Click OK to create the solution. 

The new solution will be opened in Solution Explorer.  Notice that it contains no 

projects.  To add a project, you may create a new project or open an existing project 

as detailed above, making sure to use the “Add to Solution” options when doing so. 
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File Definition Document Editor 

The designer allows you to make changes to an underlying source file.  This source 

file is an XML document, which adheres to the DataGate File Definition XML Schema.  

If you wish, you can edit the document directly, using the DataGate Studio XML 

editor.  You can even have your file definition open in both the designer and XML 

editor simultaneously – changes made in one are reflected immediately in the other.   

When the file definition is open in the designer view window, you may use the Code 

command on the View menu to open the definition in the XML editor view, as shown 

below.  You can alternately open the source file in the XML editor view by right-

clicking on the source file in the DataGate project in Solution Explorer, and selecting 

the View Code command. 

 

DataGate Studio uses the File Definition XML Schema to provide integrated file 

definition syntax error checking, highlighting, and IntelliSense® features when 

editing the file definition in the XML editor.   

Note that if you make changes in the XML editor that result in an invalid XML 

document, or a violation of the schema, the design view of the source file may be 

disabled, since the designer cannot interpret the document.  Even so, the XML editor 

can be handy for making large, “cut & paste”-style changes to a file definition. 

Other Database File Designer Topics 

File Definition Root View 

Reference File View 

Physical Record Format View 

Logical Record Format View 

Join Record Format View 

Creation Attributes View 

     Other Database File Definition Topics 

Create a Database File 
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Step 2 - Add Database File Definitions  

DataGate projects are composed of file definition source files.  These may be used to 

design and create database and print files.  To do so you must add file definition source 

files to your project.  You may add new file definitions based on DataGate project 

templates, or you may add existing file definitions source files.  You can also import the 

definitions of existing database files via DataGate Explorer. 

To Add a New File Definition 

1. Create or open a DataGate project/solution. 

2. In Solution Explorer, select the project in which the new file definition will be added. 

Note that if the solution is composed of only one project, Solution Explorer may only 

show that project node, and no solution node.  If more than one project exists in the 

solution, the project nodes will be shown under the root solution node. 

3. Select Add New Item from the Project menu.  The Add New Item dialog is 

displayed. 

The Add New Item command is shown on the Project menu only when a project is 

selected in Solution Explorer.  If you don’t see the command, make sure you have a 

project or solution open in Solution Explorer, and that the correct project is selected. 

4. Select the new file definition template corresponding to the file definition type to 

be added to the project (see File Types). 

DataGate items will only be shown if the Add New Item command is executed while a 

DataGate project is selected in Solution Explorer. 
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File Types 

Physical File Definition - A file that contains data and only one record format. 

Simple Logical File Definition - A file that contains no data. Simple logical files are 

used to arrange data from one physical file into different formats and sequences. 

Join Logical File Definition - A file that contains data "joined" from two or more 

physical files into a single record format.  

Multiformat File Definition - A file that contains data and more than one record 

format. 

SQL Logical File Definition - A SQL file that allows you to enter SQL statements to 

query the file. 

Print File Definition - A file used to create printable reports. 

 

Adding an Existing File Definition 

To Add an Existing File Definition 

Occasionally, you may want to add a copy of a file definition from a previous project to 

your current project.   

1. 
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Importing a Database File Definition 

A common task is to modify or create a new file based on the definition of an existing 

database file.  DataGate Explorer makes it easy to import file definitions into your 

DataGate project. 

To Import a Database File Definition 

1. Create or open a DataGate project/solution. 

2. Open DataGate Explorer, and connect to the database containing the file to import.  

Navigate to the file in DataGate Explorer. 

You may need to first add a database name and connection to connect to the 

database containing the file. 

3. Right-click on the file, and select Copy Filedef Source To Project. 

The Copy Filedef Source To Project command is only one way to import a file 

definition from a database.  A “drag & drop” shortcut is described below. 

4. If the solution consists of more than one DataGate project, the Project Chooser 

dialog will appear.  Select the target project for the import operation, and click OK, 

or click Cancel to abort the import. 

Note that if the solution contains only one DataGate project, the file definition is 

imported directly into that project without the Project Chooser dialog. 

5. A file definition source file is added to your project with a name corresponding to the 

name of the database file it was imported from.   

Importing a Database File Definition (Drag & Drop) 

To Import a Database File Definition (Drag & Drop) 

1. Create or open a DataGate project/solution. 

2. Open DataGate Explorer, and connect to the database containing the file to 

import.  Navigate to the file in DataGate Explorer. 

You may need to first add a database name and connection to connect to the 

database containing the file. 

3. Click on the file in DataGate Explorer, and drag to the Solution Explorer window.   

4. Drop the file onto the DataGate project node into which the file definition should be 

imported. 

5. A file definition source file is added to your project with a name corresponding to the 

name of the database file it was imported from.   
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Step 3 - File Definition Designers Overview 

The file definition designers in DataGate Studio allow you to quickly find, view, and edit 

file definition features.  DataGate Studio provides two designers: the Print File Designer 

and the Database File Designer.  Each designer operates as a standard document 

window in the IDE.   

The “code behind” for these designers is an XML document, which you may also edit 

directly using the DataGate Studio XML editor.  The XML schema for file definition 

documents is installed with DataGate Studio, so the XML editor features schema 

validation checking and IntelliSense® support.   

Print File Definition Designer Overview 

Database File Definition Designer Overview 

Database File Definition Designer Overview 

The Database File Definition Designer is DataGate Studio’s graphical user interface for 

simplifying the development of DataGate database files.  It presents database file 

definitions in a set of organized property groups, allowing you to quickly drill down to 

focus on each of the main functional areas of the file.  The Database File Definition 

Designer is invoked by opening a database file definition source file (extension “.dgdef”) 

in a DataGate project. 

The designer is strictly for editing file definition source files.  When you make changes in 

the designer, you are changing a file definition source file in your DataGate project, not 

a DataGate database file.  You cannot directly create or modify database files in the File 

Definition Designer.  After designing a file definition, you save changes to the source file 

in the DataGate project, which can then be used with a separate project command to 

create a database file. 

Designer Layout 
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The primary layout of the designer features a tree view on the left, and details panel on 

the right.  The tree view displays a high-level view of the file definition.  The root node 

represents the file type (physical, simple logical, multiformat, join, or SQL logical) and 

the file-level attributes of the definition.  Under the root node, you will see nodes 

representing major functional components of the file.  In the case of the physical file 

definition shown above, three tree nodes are displayed under the root node, 
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The asterisk indicates that un-saved changes have been made to the file definition.  

You should save your changes often using one of the DataGate Studio Save 

commands on the File menu.  When you successfully save your changes, the editor 

removes the asterisk from the tab, indicating that all changes are saved. 

The Database File Designer also supports the Undo and Redo commands.  Thus if 

you change your mind about one or more changes, simply invoke the Undo 

command on the Edit menu (or Ctrl-z) for each change you wish to reverse.  Note 

that you can Undo or Redo changes even after you save them to the source file.  

Thus, the un-saved changes asterisk may disappear and reappear as you invoke 

Undo and Redo. 

 

Step 4 - Entering Database Field Data Types 
 

To set the data type of a field in Database File Definition Designer, you must enter a 

data type keyword, and optional parameters corresponding to the type, in the Data 

Type cell of the field row, as shown below. 
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As you enter the type, a “most recently used” list of similarly named types may be 

shown, as with the Packed type in the above example, which can help you quickly 

enter the type definition. 

 

Also, the Data Type grid cell validates your entry, and displays an error icon on the 

row if your data type selection is invalid, as shown below.   

 

 
 

Placing your mouse cursor over the error icon will display a pop-up panel detailing 

the problem, as shown below.  The error in this case is that the user has entered an 

invalid value for the precision of the Packed field.   
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Data Type Keywords and Parameters 

 

The following table gives the list of available data type keywords, their qualifying 

parameters, and example usages. 

 

Data 

Type 

Keyword 

Description Parameters Example 
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Step 5 – Adding a Key 

A key determines the order in which records will be retrieved from the file. 

To Add a Key to a Record Format 

1. Open the physical file definition source file in the Database File Definition Designer.   

2. In the details tree view of the designer, select the record format node as shown 

below with the RCMMASTER record format. 

3. Select the Keys tab in the lower right panel to display the keys grid as shown below.  

 

4. Scroll to the bottom of the keys grid, if necessary.  Select the New Row (the last 

row of the grid) by clicking on the leftmost column of the row. 

5. Select the name of the key part to add by clicking on the drop-down box in the 

KeyName cell as shown below.  Modify the remaining default column values of the 

New Row to reflect the attributes of the key part to be added to the record format.  

Note that a key part will not be added to the format until you select a field or make a 

change to the default data. 
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You can change attributes of the key part by modifying the following column 
parameters. 

KeyName: 

Click on the arrow on the right of the key name cell and select one of the available 

fields to designate as a key field. A key name is required.  

Key Order: 

Click on the arrow on the right of the key order cell to select the order in which the 
key field will be sorted. The default is ascending order. 

Ascending - Alphabetical order, from A to Z. 

Descending - Alphabetical order, from Z to A. 

Key Usage: 

Select a usage by clicking the arrow on the right of key usage cell. The following are 
the available usage types. 

Absolute Value – Absolute value numeric sequence. 

Signed - Algebraic numeric sequence. 

Unsigned - Ignore the sign when sorting. 

Digit - The low nibble of each byte of the key field. 

Zone – A numeric type where there is a byte per digit, divided into a low and 

high nibble. 

You can add a maximum of 32 key fields. The total length of the key can be up to 
250 Bytes. 
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Inserting a New Key Part before an Existing Key Part 

To Insert a New Key Part before an Existing Key Part 

1. Append the new key part as detailed above. 

2. Select the new key part row, then click and drag the row to the key part row in the 

grid where you want to insert the new key part. 

3. Drop the new key part on top of the existing key part.  The new key part is inserted 

before the existing key part. 

 

Step 6 – Adding a Select/Omit Rule  

When a logical file record is to be accessed by a program, the select/omit rules are 

evaluated sequentially by the database until an expression is found to be true, then the 

related action (Select or Omit) is taken.  

Use the *TRUE keyword to specify the action to be taken after all other Select/Omit 

statements have been processed. Specify "Select: *TRUE" to direct the database to 

select any records that do not meet any of the previous Select/Omit rules. Conversely, 

specify "Omit: *TRUE" to omit any records that do not meet any of the previous 

Select/Omit rules. 

If the *TRUE rule is omitted, the default action is to presume you want all remaining 

records to be either selected or omitted depending upon the last Select/Omit statement. 

That is: 

• If the last statement was a Select, the default is to assume "Omit: *TRUE" wherein 

all records that did not meet the any of the previous Select/Omit rules will be 

omitted. 

• If the last statement was an Omit, the default is to assume "Select: *TRUE" wherein 

all records that did not meet the any of the previous Select/Omit rules will be 

selected. 

To Add a Select/Omit Rule to a Logical Format 

1. Open the physical file definition source file in the Database File Definition Designer.   

2. In the details tree view of the designer, select the record format node as shown 

below with the RCMMASTL1 record format. 

3. Select the Select/Omit tab in the lower right panel to display the select/omit grid 

as shown below.  



Creating a Database File                                                                                                            17 

 

4. Scroll to the bottom of the select/omit grid, if necessary.  Select the New Row (the 

last row of the grid) by clicking on the leftmost column of the row. 

5. Select the rule verb by clicking on the drop-down box in the Verb cell as shown 

below.  Change the rule expression from the default “*none” to a logical expression 

pertaining to the rule.  Note that the rule will not be added to the format until you 

select a verb and enter an expression. 

 

A logical expression consists of a field name, an operator, and a constant. The valid 

relational operators are: >, >=, <, <=, =, !=,. Refer also to the illustration below 
comparing AS/400 and DataGate coding of rules. 

Illustration: 

The Select/Omit Rules below compare the rule implementation in DDS and DataGate . 

DDS Example: 

O PRTDSC COMP(EQ 'HAMMER') 

S UNTPRC COMP(GT PRCLVL) 

ONHAND COMP(LT 10) 

O  ALL 
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The same rules as above coded for DataGate : 

Omit:  PRTDSC = 'HAMMER' 

Select: UNTPRC > PRCLVL & ONHAND < 10 

Omit:  *TRUE 

If the expression is incorrectly constructed, an error may occur when creating the file. 

 

Step 7 – Creating a File 

Before you create a file, ensure that the database file definition, record 

format, fields, keys, and Select/Omit Rules are exactly as you want them. Use 

the Database File Definition Designer, Print File Definition Designer, or XML 

editor to create the file definition.  Once a file is created, you cannot make 

any changes to its definitions. 

To Create a File 

1. Open or create the DataGate project in Solution Explorer containing the file 

definition source file from which you will create the database or print file. 

2. After editing the file definition in Database File Definition Designer, Print File 

Definition Designer, or the XML editor, save your changes. 

3. Select the file definition source file from the DataGate project in Solution 

Explorer.   

4. Right-click on the file node, and select Create File from the context menu.  The 

Create DataGate File dialog is displayed as shown below. 

 

 
 

5. On the Location tab, as shown above, enter the name of the new file, the library it 

should reside in, the database connection to use, and text comments to associate 

with the created file. 
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6. The following attributes can be set on the Location tab. 

File Name: 

The name of the selected database file definition source file node will display by 

default. You can however, change the name of the file to create.  Note that some 

databases, notably the iSeries, restrict file name length. 

Text: 

By default, no text comments are displayed. If you want to associate a comment 
with the created file object, you can enter it at this time.  

7. On the Member tab, you may specify a member name, (as shown below).  If a 

member name is specified, a member object will be added to the file with that name, 

upon successful creation of the file.  You may also indicate text comments to 

associate with the member, and, for logical members, the base member(s) of the 

logical member. 

 

 
 

The following attributes can be set on the Member tab. 

Name: 

*FILE will display as the default member. *FILE is a keyword indicating that the 

member name should be the same as the file name.  You can change the default 

member name, or leave the Name field blank to indicate that no member should be 

added to the created file. A file must contain at least one member to be used in a 

program. 

Base Members: 

If the file definition defines a logical file, and the base file in the format is verified on 

the target database, you may select one or more of the members of the base file as 

base members for the logical member.  Place a check next to each member which is 
to be a base member for the logical member added. 
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Text: 

Enter a text description of the contents the member will contain. 

8. Click OK to begin creating the file, or Cancel to close the dialog without creating a 

file.  Observe progress and any errors produced by the command in the DataGate 

Studio Output and Error List windows. 

 


